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Digital Dave
“Digital Dave answers your tech questions.” by Digital Dave

Accessing Router Setup; Computer Speed and Fonts; Computer Won't Reboot or Shutdown Correctly.

Accessing Router Setup
Dear Digital Dave,

When I type http://192.168.1.1 in my Internet Explorer browser Google Search provides me
with everything except my router's login. How can I get the browser to take me directly to
the address that I type?

Poz
San Diego, CA

Dear Poz,

I see two possible problems. First, be sure that you are entering the IP of the router into the
address field and not merely a Google Search field. Most of today's browsers use the same
field and whenever an IP or URL is entered it will take you directly to that address. If it is not
a direct address, then the search engine kicks in giving a list of options. However, it is quite
possible that you have a separate address field (where the URL of the current page is viewed).
Make sure you're using that one.

The second possibility is that you have the wrong address for the router. While
http://192.168.1.1 is commonly used, it could be another address such as http://192.168.0.1—
especially if it was changed during initial installation. If you run netstat -n in the Command
Prompt, you will find the router IP somewhere close to the top of the list. If you get the right
address in the proper address field, then the router administrative login page should pop-up.

It's also possible that your browser has been hijacked by some lameware which was
inadvertently installed. Check your add-ons and disable/uninstall any suspicious extensions.
You may also need to remove them via Programs and Features.

Digital Dave
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Computer Speed and Fonts
Dear Digital Dave,

Is there any truth to the idea that having too many fonts loading at start-up will slow the
process? If true: Which ones would you recommend I keep and which ones should I remove
(or copy to a flash drive "just in case")?

Tony S
San Diego, CA

Dear Tony,

Yes, it is true, but you need to have hundreds of extra fonts installed to cause much of a slow
down at startup. Even if you do have numerous fonts which were installed with various word
processing and art programs, there is a way to prevent their loading at startup without
removing them.

Go to Control Panel => Appearance and Personalization => Fonts to view the fonts (see
Figure 1). Many of the fonts should already be grayed indicating that they are hidden.
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Figure 1. To Hide a font, right-click on the font (or selected group of fonts).

When a font is hidden it will not load on start up. However, an even bigger problem could be
using a program such as Photoshop. The loading of extra fonts (sometimes thousands) can be
a serious drag when loading the program. In that case, you may want use "Restore default font
settings" which can be found by clicking "Font Settings" in the left pane shown in Figure 1 (see
Figure 2).
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Figure 2. Restore default font settings will return fonts to the original configuration.

You may want to backup all of your fonts before you do this.

Digital Dave

Computer Won't Reboot or Shutdown Correctly
Dear Digital Dave,

I have a Lenovo desktop I bought about 1½ years ago with Windows 8.0. I have done all the
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upgrades to Windows 8.1 and there have been many. I did install Start8 in the beginning to
get past the icons.

Apparently during an earlier update requiring a reboot, I found the computer wouldn't
completely shut down or restart, even after leaving it for an hour or more. I will have to
press the stop button for the required time to complete the shutdown, then repress it to
restart. It's been this way for nearly a year. When I restart it, other than some long
waits(five or more minutes and that can be part of some update installs), there doesn't ever
seem to be anything wrong with its normal operation.

I have tried to access the Microsoft Knowledge Base and I find nothing related. One
thought, could there be a damaged DLL. I can't find any "reliable" online scan for damaged
or missing DLLs that used to exist years ago. I will appreciate any thoughts on this.

Keith
Highlands Ranch, Colorado

Dear Keith,

There is a built in System File Checker which will scan and repair system files. Open the
Command Prompt (search settings +Q for "Command Prompt" and right-click on the
filename or icon. Select "Run as administrator"). Enter the following:sfc /scannowThis scan
will take some number of minutes (see Figure 3). If the computer doesn't come up clean,
consult this Microsoft page.

Figure 3. The System File Checker (sfc) restores corrupted files.

A more drastic step is to Refresh or Reset the operating system. Understand that you will most
likely need to reinstall some programs, but check the online documentation for how to
proceed.
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Digital Dave
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OS X Yosemite's Top Features of Interest
for Windows Users

“Apple's Newest Macintosh Operating System Has a Lot for Windows Users to Like.”
by Barry Fass-Holmes

"If my guess above is correct, Windows users might be interested in Apple's newest operating system for
Macintosh, OS X 10.10, aka Yosemite, and its features which would appeal to these users' cost
consciousness and/or price sensitivity."

"One of the first things I do with a new computer is…download Microsoft Security
Essentials. It's free!"

—Digital Dave, ComputorEdge, August 1, 2014

I have the distinct (perhaps mistaken) impression that many Windows users are very cost-
conscious and/or price-sensitive. Like Digital Dave (as exemplified by his exclamatory remark
above), these users typically delight in purchasing products at a discount or, seemingly better
yet, obtaining products which have no monetary cost ("free").

Recently released is Jack's FREE AutoHotkey book…

Jack's A Beginner's Guide to AutoHotkey, Absolutely the Best Free Windows Utility Software
Ever!

Special Free Offer at ComputorEdge E-Books!
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—Jack Dunning, ComputorEdge, January 9, 2015

This delight in successful bargain hunting or freebie getting is somewhat puzzling for the
following two reasons. First, there truly are no free lunches in life. Everything, including the air
we freely breathe, has a price to be paid. The price might not be monetary, but a price does
exist. So, the price users pay for "free" software might be in the form of time—time spent
searching for, downloading, installing, and maintaining such software. What's puzzling about
this? Unless you are capable of reincarnation and/or time travel, once you spend time, you
cannot regain it. Money, by contrast, can be replaced and/or earned back. And if the saying
"time is money" has merit, then the time spent in search of discounts and/or freebies is a bona
fide price.

My second reason for being puzzled by Windows users' delight in successful bargain hunting
or freebie getting is that this delight seems to be relatively specific to computer-related
products. I'm guessing (could be mistaken) that cost-conscious and price-sensitive Windows
users pay for their homes rather than living someplace that's free, and that these homes cost
more than other ones which were available at the time of purchase. Likewise for such users'
furniture, vehicles, food, etc.

If my guess above is correct, Windows users might be interested in Apple's newest operating
system for Macintosh—OS X 10.10, aka Yosemite—and its features which would appeal to
these users' cost consciousness and/or price sensitivity.

Yosemite's potentially most appealing feature for cost-conscious and/or price-sensitive
Windows users is its price. OS X 10.10 is free. It is free for buyers of currently available new
models of Macs (included in their purchase price), and it also is free (without any cost, product
key, license number, or serial number) for owners of Macs purchased with a pre-installed
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recent version of OS X—Mavericks, Mountain Lion, Lion, or Snow Leopard. Owners of 10.5
Leopard or earlier versions are required to purchase 10.6 Snow Leopard ($19.99) and then
upgrade to Yosemite at no additional charge. How much does Microsoft charge owners of
Windows 7, Vista, or XP to get Windows 8?

OS X Yosemite by Apple

Description
Upgrade your Mac to OS X Yosemite and you'll get an elegant design that's both fresh and
familiar. The apps you use every day will have powerful new features. And your Mac, iPhone,
and iPad will work together in amazing new ways. You'll also get the latest technology and the
strongest security. It's like getting a whole new Mac—for free.

1. Free
2. Category: Utilities
3. Updated: Nov 17, 2014
4. Version: 10.10.1
5. Size: 5.17 GB

Another compelling feature of Yosemite is the price of its built-in productivity programs. OS X
comes with an e-mail client (Mail), calendar program (Calendar), digital image editing and file
format converting utility (Preview), digital pictures management program (iPhoto), music
management program (iTunes), music development program (GarageBand), and system
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backup program (Time Machine). These programs (together with other more mundane ones)
come pre-installed on new Macs along with Yosemite. Did I mention that they are free?

But wait, there's more that would delight cost-conscious and/or price-sensitive Windows users.
If you purchase a new Mac with Yosemite pre-installed, you also get Apple's triumvirate of
additional productivity programs which are (mostly) compatible with Microsoft Office's file
formats. These additional productivity programs are Pages (which imports and exports .docx
files), Numbers (.xlsx files), and Keynote (.pptx files). The cost for Apple's three productivity
programs? Zero, as in "free." The free price tag, however, does not apply to owners of older
Macs which shipped with a previous version of OS X. They have to pay $19.99 for Pages,
$19.99 for Numbers, $19.99 for Keynote (just under $60 for all three). How much does
Microsoft charge for new or upgrade Office licenses? Admittedly, Redmond's software
developer does have lower-cost subscription plans for Office 365, but it's not free. Guess
when Microsoft's Office 365 lower-cost subscriptions became available relative to when Apple
made its productivity threesome free for Macintosh users. Hint: April 15, 2014 vs. October 22,
2013.

Pages By Apple

Description
Create gorgeous documents in minutes with the all-new Pages
for Mac word processor—featuring a stunning new design, new
writing tools, and improved performance. Start with an Apple-
designed template or create your own design using fonts, styles,

and tools from the intelligent Format Panel. Easily add images, movies, charts, and more. And
use change tracking, comments, and highlights to review your work.

Keynote by Apple

Description
Easily create gorgeous presentations with the all-new Keynote,
featuring powerful yet easy-to-use tools and dazzling effects
that will make you a very hard act to follow.
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Numbers by Apple

Description
Create gorgeous spreadsheets with the all-new Numbers for
Mac. Get started with one of many Apple-designed templates
for your home budget, checklist, invoice, mortgage calculator,
and more. Add tables, charts, text, and images anywhere on
the free-form canvas. As soon as you start typing a formula,

you'll get instant suggestions and built-in help for the over 250 powerful functions. Animate
your data with new interactive column, bar, scatter, and bubble charts. Easily filter through
large tables. Automatically format cells based on numbers, text, dates, and durations with new
conditional highlighting. And with an all-new calculation engine, Numbers is faster than ever
before.

A third free feature of Yosemite is its built-in compatibility with Windows networks. Yosemite,
like previous versions of OS X, natively supports the following Windows assets without any
additional third-party involvement: Microsoft Exchange Server calendars, contacts, and e-mail;
digital cameras, printers, hard drives, pointing devices, and keyboards with USB connections;
Wi-Fi hotspots and Windows networks; file formats including but not limited to DOC, XLS,
PPT, PDF, JPG, ZIP, MP3, PSD; and instant messaging with AIM, MSN, or Yahoo. Did I
mention that this compatibility is free?

And one more thing…Yosemite-equipped Macs can run Windows natively. Whoa, did you say
Macs can run Windows? I thought they were proprietary. Bzzzt, wrong. Macs have been
capable of running Windows natively since 2006 when Apple switched to Intel processors that
natively run Windows on PCs. Apple provides software called Boot Camp which is used in
partitioning a Mac's hard drive and installing Windows within its own partition. Did I mention
that Boot Camp is free?

Users who want to run Windows programs on a Mac without having to use Boot Camp's dual-
boot configuration instead can run Windows programs side-by-side with Macintosh-native
programs; however, this requires either virtual machine software such as the free open-source
program VirtualBox or a program that runs Windows programs without having Windows
installed such as the free open-source program Wine.
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Windows 8 developer preview, or just about any other version, runs in a virtual machine on an Intel Macintosh.

Windows programs, like Word, run without Windows in Wine or its commercial counterpart CrossOver on
Macintoshes.

In summary, Apple's newest Macintosh operating system (Yosemite) has a lot for cost-
conscious and/or price-sensitive Windows users to like (they might not like the price of brand-
new Macs, however; Apple does routinely sell refurbished, warrantied Macs at lower price
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points). Yosemite has many notable free features (its price, built-in productivity programs,
additional triumvirate of Office-compatible productivity programs, its compatibility with a wide
variety of Windows assets, and its ability to run Windows natively). As mentioned previously,
however, there truly are no free lunches in life and switching from Windows to Mac has its
own price—the time for converting to and learning a new computing environment. My
experience was that the time saved by abandoning Windows' maintenance and configuration
requirements far outweighed the time spent learning Macintosh.

Windows users who are interested in learning more about Yosemite and its new features
(Continuity, Handoff, Instant Hotspot, redesigned user interface, etc.) can check out the Mac
App Store's Web page or Wikipedia's article.

Barry Fass-Holmes has been reviewing products for ComputorEdge since 2003. He
previously worked as a software support representative and quality assurance analyst in San
Diego. His product reviews are available in ComputorEdge's archives and at his Web site.
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The Easy Way
to Build
AutoHotkey
App Windows
“How to Steal GUI Code

from Any AutoHotkey Window, Plus More SmartGUI Creator Features” by Jack
Dunning

Save time by quickly cloning the code from any active AutoHotkey window, plus, more useful SmartGUI
Creator techniques.

This column is a continuation of the discussion of the easy-to-use AutoHotkey GUI
(Graphical User Interface) code generator SmartGUI Creator 4.0 by Rajat which helps to
build app windows. If you're familiar with the Gui, Add command, then this column will be
no problem. If not, then you will find the GUI (Graphical User Interface) command is
introduced in A Beginner's Guide to AutoHotkey , discussed in the Digging Deeper into
AutoHotkey e-book, and covered in some depth in AutoHotkey Applications.

If you own a Windows computer and you're not familiar with AutoHotkey, you should be!
See this Introduction to AutoHotkey!

*                    *                    *

In the last AutoHotkey column I introduced the clever AutoHotkey tool SmartGUI Creator
4.0. While the features demonstrated last time were impressive, there are more features worth
discussing—in particular, its ability to steal the code from other AutoHotkey windows without
copying (or even seeing) the original code. This can be a tremendous time saver when building
new AutoHotkey scripts whether copying your own app windows or borrowing the layout
from other scripts you find on the Web.

Stealing GUI Layouts from AutoHotkey Windows
While creating a GUI layout is easy and intuitive with SmartGUI Creator, it still takes a little
time to place the controls exactly where you want them. What if there already existed an
AutoHotkey app window which looked exactly the way you wanted your new window to
appear (or was at least close to it)? With the SmartGUI Creator GUI Stealer, you can copy the
layout directly for any AutoHotkey window without even looking at the underlying code—
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even if the app is compiled.

The first step is to load SmartGUI Creator and select File => GUI Stealer. The new layout
window will appear as in Figure 1.

Figure 1. Use File => GUI Stealer to initiate the feature for copying the layout of another AutoHotkey window.

Load the AutoHotkey script which contains the window you plan to replicate. Activate that
app window by either selecting it or using the proper key combination built into the app (see
Figure 2), then hit the F12 key. (In this example, I used the GUI window from the Calorie
Count script posted ComputorEdge AutoHotkey download site.)
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Figure 2. The Calorie Count script window is loaded and activated to test the GUI Stealer feature of SmartGUI Creator.

The layout of the selected AutoHotkey window is copied onto the SmartGUI Creator layout
grid (see Figure 3). That is all there is to it!
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Figure 3. The Calorie Count window layout is reproduced on the SmartGUI Creator layout window.

After saving the test code copied from the Calorie Count script, the generated code and the
original code are compared (see Figure 4).
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Figure 4. The generated test code (top) is significantly different from the original Calorie Count script code (bottom),
but they look the same when loaded.

When comparing the two versions of the layout, notice that the generated code (top) is in
absolute coordinates while original layout uses a variety of positioning options. Whether there
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are any advantages to using the original positioning options over the generated coordinates is
dependent upon other features within the script. Also, designated variable names and label
(subroutine) names within the options will not be copied. These modifications, if needed, must
be added to the script later.

It's important to remember that SmartGUI Creator is not designed to write an entire script. Its
primary function is to quickly create a layout for an AutoHotkey GUI window and generate
the script code. Once the code is written, it can be copied, added to a new script, and modified
as necessary.

We're not done yet! There are a few more useful features included in SmartGUI Creator.

Micro-Positioning GUI Controls with SmartGUI
Creator
By default, SmartGUI Creator uses a snap-to-grid feature (10 pixels squares) for any controls
added to the layout. The controls automatically align with the default grid. This is great for
easy alignment, but what if you want to place a control between the grid lines? The first way
to more precisely placed controls is by turning on the MicroEditing feature (Options =>
MicroEditing and check the option). When checked the snap-to-grid feature is removed and
allows positioning a control at any location.

The second method is to use the control right-click context menu to Set Position (See Figure
5). A Set Position window opens where the exact coordinates can be adjusted, as well as, the
width and height of the control.
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Figure 5. With the Set Position option the exact location and size of a control can be adjusted with the pop-up window.

When OK is clicked, the control moves and/or resizes.

Adding AutoHotkey Labels (Subroutine) Names
Many of the AutoHotkey GUI controls automatically create default label (subroutine) names
by combining the text added to the control with the control type. From the online
documentation: "If a button lacks an explicit g-label, an automatic label is assumed. For
example, if the first GUI window contains an OK button, the ButtonOK label (if it exists) will
be launched when the button is pressed. For GUI windows other than the first, the window
number is included in front of the button's automatic label; for example: 2ButtonOK."

SmartGUI Creator does not create label names for the g-label option which is often added to
GUI controls, but rather uses the default form of names generated from the added text. If it
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did create g-labels, then it would also need to create the subroutine at the same time.
Otherwise, when testing it would generate the missing label error "Target label does not exist."
This might be a little confusing for people looking for a way to add g-labels—which
SmartGUI Creator doesn't do. Don't use the Custom Option in an attempt to add g-labels
since that will also generate a test error. Add them later when editing the AutoHotkey script
code.

Edit the text shown in the control with the Change Label option (right-click on the control,
then select Change Label). An editing window opens which allows the text, which is also part
of the default label name combination (if available for the control type), to be changed (see
Figure 6).

Figure 6. Default labels are created with the text added for the appropriate type of controls, but g-labels are not added to
the code.

It's probably best to think of the Change Label features as merely an editor for the text at the
end of the control's line of code. Any g-label names and their associated subroutines must be
added after the GUI code is generated. Initially, I would concentrate on making the text read
the way I want and worry about the subroutine labels later.

Adding Options to GUI Controls

There is a list of options which can be added to any specific GUI control by right-clicking on
the control and selecting Custom Option. If selected the option will be added to the line of
generated code. For example, I right-clicked on the Food edit field and selected Custom
Option to open the selection menu (see Figure 7). I then selected Uppercase and hit return.
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Figure 7. Options may be added to any of the GUI controls with the Custom Option menu.

When saved, the new code included the +Uppercase option in that line of code:

Gui, Add, Edit, x150 y330 w350 h21 +Uppercase, Food

The test preview shows that the +Uppercase option forces all input into capital letters (see
Figure 8).
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Figure 8. Adding the +Uppercase option to the code capitalizes the letters.

Understand that not all options apply to all controls. You must check the online GUI
documentation to see what options will work with which controls. Plus, SmartGUI Creator
adds a plus sign to every option. Many options do not use the plus sign and it might need to be
removed later in the script.

Since SmartGUI Creator uses a Combo Box for adding options, additional parameters may be
added to any option by typing them into the top editing field prior to pressing the ENTER key.

Move Group
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It's worth mentioning that there is a Move Group mode which allows you
to select an entire set of controls and move them with the cursor buttons
in the Move Group window (shown at left). It is activated by clicking and
holding the left mouse button at the upper left-hand corner of the desired
selection area until a little square appears. Then dragging the mouse
without letting up until the entire range is selected will include all the
encompassed controls. The Move Group window will pop open.

Click the Advance button to view the selected controls. To add or remove
controls from the movement area, use CTRL+LEFT-CLICK. The
number appearing in the center of the cursor buttons sets how many pixels
to move the group with each click of an arrow button. This certainly beats
moving the controls by dragging them one at a time. If you find that this
mode is activating too easily, check Shift + Move Group from the top
Options menu (Options => Shift + Move Group). SmartGUI Creator will

then require holding down the SHIFT key while activating Move Group.

The other features found in SmartGUI Creator, yet not discussed, are intuitive and self-
explanatory. For additional insight and tips, I encourage you to read the documentation and
short tutorial which comes with the app. SmartGUI Creator is an extremely capable
AutoHotkey GUI window code generator. It's easy to create a new layout or steal one from
another AutoHotkey app window. In most cases, it will be the best way to start a new
AutoHotkey app.

There are a number of places where SmartGUI Creator can be downloaded, but I wasn't sure
which was the best. So once I had it downloaded I decided to provide it on the ComputorEdge
AutoHotkey download site. The ZIP file (SmartGUI.zip) contains three files: SmartGUI.exe
(the main program—no installation required), Manual.htm (a short tutorial), and calc.ahk (a
sample AHK file). After downloading the ZIP, these files should be extracted to your folder of
choice.

*                    *                    *

Not sure which e-book format you need for your iPad, Kindle, PC, Mac, Android or other e-
book reading device? Get all three formats at once (EPUB for iPad, Android and PCs, MOBI
for Amazon Kindle, and PDF for reading or printing on standard notebook size paper) for any
of the AutoHotkey e-books at one special price at ComputorEdge E-Books. (Note: If
something goes wrong during a download and you run out of downloads, e-mail us or gives us
a call and we'll give you more downloads at no extra charge.)

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first
issue on May 16, 1983. Back then, it was called The Byte Buyer. His Web site is
www.computoredge.com. He can be reached at ceeditor@computoredge.com. Jack is now in
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the process of updating and compiling his hundreds of articles and columns into e-books.
Currently available:

Recently released is Jack's FREE AutoHotkey book, AutoHotkey Tricks You Ought to Do
with Window, available exclusively at ComputorEdge E-Books in the EPUB for e-readers and
tablets, MOBI for Kindle, and PDF for printing formats.

ComputorEdge E-books is offering his AutoHotkey Applications, an idea-generating
intermediate level e-book about using the AutoHotkey Graphical User Interface (GUI)
command to write practical pop-up apps for your Windows computer. (It's not as hard as it
sounds.)

Hidden Windows Tools for Protecting, Problem Solving and Troubleshooting Windows 8,
Windows 7, Windows Vista, and Windows XP Computers.

Jack's A Beginner's Guide to AutoHotkey, Absolutely the Best Free Windows Utility Software
Ever!: Create Power Tools for Windows XP, Windows Vista, Windows 7 and Windows 8 and
Digging Deeper Into AutoHotkey.

Our second compilation of stupid ComputorEdge cartoons from 2011 and 2012 is now
available at Amazon! That Does Not Compute, Too! ComputorEdge Cartoons, Volume II:
"Do You Like Windows 8 or Would You Prefer an Apple?"

Special Free Offer at ComputorEdge E-Books! Jack's Favorite Free Windows Programs:
What They Are, What They Do, and How to Get Started!.

Misunderstanding Windows 8: An Introduction, Orientation, and How-to for Windows 8
(Seventh Edition)!

Windows 7 Secrets Four-in-One E-Book Bundle,
Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using
Windows 7,
Sticking with Windows XP—or Not? Why You Should or Why You Should Not Upgrade to
Windows 7,
and That Does Not Compute!, brilliantly drawn cartoons by Jim Whiting for really stupid gags
by Jack about computers and the people who use them.
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Wally Wang's Apple Farm
“Wisdom Teeth for Computers” by Wally Wang

Wisdom Teeth for Computers; Why You Want to Develop for iOS; Free Education in iOS and OS X
Development; The Decline of Software Quality in OS X and iOS; Understanding Sabermetrics; The
Markup Toolbar.

The common belief is that wisdom teeth existed when humans had larger jaws and needed
wisdom teeth to grind down tough plants for food. Unfortunately as humans evolved (although
some insist on staying as backwards as possible), the human jaw got smaller but wisdom teeth
still remained. When wisdom teeth don't have enough room, they can cause problems, which
is why dentists extract wisdom teeth.

At one time, wisdom teeth served a purpose. Now they're just a nuisance at best. Yet when
you look around the computer world, you can find plenty of archaic vestiges of the past that
once had a purpose but make no sense for today just like wisdom teeth.

Ask new computer users why hard disks in Windows are labeled the C: drive and they'll likely
have no clue. Yet even as late as Windows 8.1, you can still see drives labeled as C: or D:
drives. Logically, someone might wonder what ever became of A: and B: drives, but if they
weren't around during the early days of PCs, they might never know the answer.
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Figure 1. Windows 8.1 still refers to hard drives as the C: drive.

In the early days when computers only had floppy disks, the first two floppy drives were
labeled the A: and B: drive. With MS-DOS, you had to specify which drive you wanted to use
such as telling a program to save a file on the A: drive (the first floppy disk) or the B: drive
(the second floppy disk).

When hard disks became popular, MS-DOS 5.0 designated the C: drive as the hard disk. With
a hard disk, few people had a reason for two floppy disk drives, so computers soon only had
an A: drive (the floppy disk drive) and a C: drive (the hard disk). Eventually when floppy
drives disappeared altogether, computers were left the C: drive for the hard disk and the D:
drive for the CD/DVD drive.

Today it makes no sense to refer to the hard drive as the C: drive, yet the remnants of that era
still lingers in Windows 8.1. The C: drive designation serves no purpose any more for novices,
yet still remains to confuse novices while giving them no added benefit either. Given a choice
between making computers easier to understand or retaining ancient history that makes
computers harder to understand, you can already see which choice tech-savvy users prefer.

Another example of useless archaic information confusing novices occurs with the keyboard.
The original IBM PC keyboard stupidly combined a numeric keypad with a cursor keypad so
you couldn't use both at the same time without clumsily holding down the Shift key. Yet the
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dual function of the numeric key still remains on many of today's keyboards.

Figure 2. Many keyboards still retain the dual use of the numeric and cursor keypad.

Originally keyboard manufacturers retained this confusing labeling of keys to maintain
compatibility with software that might need these specific keys. Nowadays, no modern
software requires the specific use of the Home key on the numeric keypad when most
keyboards also have a separate Home/End keys along with cursor keypad. Yet these ancient
keys still linger, causing more confusion for no good reason.

For another example of archaic icons, ask yourself when was the last time you used or even
saw a 3.5-inch floppy disk. Now look on the toolbar of Microsoft Word 2011 for the
Macintosh and you can see a floppy disk icon that represents the Save command. Microsoft
Word 2010/2013 also recycles this floppy disk icon for its Save command, but new computer
users have never used, let alone seen, a 3.5-inch floppy disk before, so this icon makes no
sense either.

Figure 3. The floppy disk icon represents the Save command in Word 2011 for the Mac.
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Figure 4. The floppy disk icon represents the Save command in Word 2010 for Windows.

Figure 5. The floppy disk icon also represents the Save command in Word 2013 for Windows.

Icons are supposed to be easy to understand such as showing a printer for the Print command
or the scissors icon for the Cut command. Experienced computer users know what a floppy
disk looks like but today's novices do not, which makes the floppy disk icon useless to help
novices figure out how to use software.

The typical tech-savvy user response to retaining archaic symbols from the past is to force
novices to accept these cryptic and meaningless items as part of learning to use a computer,
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which makes as much sense as forcing people to learn Morse code just to use a telephone.
Rather than make computers easier to use, tech-savvy users prefer computers that are difficult
to use since it insures their own job security and self-importance.

The Vietnamese language originally relied on Chinese characters where every character
requires multiple strokes to write and memorization to know what it means and how to
pronounce it. Such a cryptic language kept most of the population unable to read and write,
forcing them to rely on scholars to do their reading and writing for them.

To simplify Vietnamese, a French Jesuit missionary converted Vietnamese to a phonetic
system to make reading and writing easier. As a result, more people could easily read and
write, lessening dependence on expensive scholars.

Today's tech-savvy users are the equivalent of Vietnamese scholars who wanted to keep
people as helpless and ignorant as possible to maximize their own status and salaries. Make
Vietnamese easier to learn and the need for scholars drops dramatically. Make computers
easier to learn and the need for tech-savvy users drops dramatically.

The reason why tech-savvy users hate simpler computer products is because it threatens their
monopoly of computer knowledge. When people can learn and use computers without relying
on expensive tech-savvy users, there's no need for tech-savvy users.

The next time you hear a tech-savvy user angrily dismiss a simpler computer product, ask
them why. Chances are good they're really frightened of losing their monopoly of knowledge
because without cryptic knowledge keeping people confused, they can no longer justify their
own existence.

Why You Want to Develop for iOS
In the first week of January, Apple announced that they paid iOS developers half a billion
dollars. Obviously not every iOS developer made a ton of money, but chances are good that
iOS developers made more money in one week than Android or Windows Phone/Windows
RT developers made in that same week.

The reason why Windows became popular during the 90's was because so many developers
could make money creating Windows programs. The more software available for Windows,
the less reason anyone had to use any other operating system.

In the mobile world, most software appears on iOS first and Android later, often never
appearing on Windows Phone at all. Despite the greater market share of Android, the iOS app
library contains far more software and iOS developers tend to make more money than
equivalent Android developers.
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Figure 6. iOS developers earn more money than other developers.

If you're a developer, you can choose either the larger market for mobile apps or focus on a
smaller market. Either way doesn't matter as long as you turn out quality products that people
will gladly buy. However, if you want to make more money with less hassle, iOS is currently
your best option.

With the growing popularity of the iPhone, the dominance in the tablet market of the iPad, and
the release of Apple Watch, developing for iOS is a safe bet to cover the mobile and wearable
computer market at once. If you develop for Windows Phone, watch out for Windows 10
knocking Windows Phone out altogether. If you develop for Android, your potential market is
much larger than iOS but the actual number of paying customers is much less.

If you're happy working harder for less money, feel free to develop for other platforms like
Windows RT and Blackberry OS. Otherwise, serious developers can't ignore iOS any longer,
which means consumers can't ignore iOS devices either.

Free Education in iOS and OS X Development
One problem with schools is that they're often too slow to react to changing circumstances.
Peek in most college catalogs and you'll find plenty of Java, C++, and even Visual Basic
programming courses but you won't find many Objective-C or Swift programming courses for
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developing OS X and iOS apps.

Rather than wait for a school to offer a course, simply go to Apple Developer's site and watch
videos from past Worldwide Developer's Conferences that explain everything from today's
WatchKit framework for developing Apple Watch apps to using Metal, Apple's latest
framework for creating the fastest graphics-intensive programs possible.

You can stream the videos or download them so you can watch them at your convenience.
You can also download the PDF file containing each session's Keynote slides. By watching
these free videos and reviewing the Keynote slides, you can get far more information that's
current than you can get anywhere else. Each session also gives e-mail addresses so you can
contact Apple's presenters if you have any questions.

Figure 7. Apple offers free videos of their Worldwide Developer's Conferences.

By browsing through Apple's Developer's site, you can also find sample source code that you
can run and modify. Nothing beats actual working code to help you learn to develop OS X or
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iOS apps, so if you're motivated, you can teach yourself OS X and iOS development
absolutely free.

With so much free information from Apple, there's no reason why developers can't start
making OS X and iOS apps as soon as possible. As Microsoft learned a long time ago, the
more developers you attract, the more valuable your platform becomes. As more developers
flock to OS X and iOS development, you can already see where the future of computing will
be heading.

The Decline of Software Quality in OS X and iOS
Back when Apple only had one size iPhone, it was fairly easy to write software for it,
including the iOS operating system. Now that Apple offers different size iPhones along with
components made by different manufacturers in both new and older iPhones, suddenly
software bugs keep cropping up more frequently.

When Apple released iOS 8.01, it killed nearly every iPhone 6 model on the market. Apple
quickly removed it and replaced it with iOS 8.02, but the damage to their reputation has
already been done.

Between the earlier Maps debacle and the latest iOS 8.01 disaster, Forbes wonders if Apple's
trying to do too much too fast. Yearly updates to both OS X and iOS sound good in theory,
but buggy updates has caused more people to shy away from updating their software. Rather
than keep releasing new versions of operating systems every year, many people want Apple to
slow down and release more stable software instead.

How can Apple keep expanding the reach of its software in smartphones, tablets, and now the
Apple Watch at such a breakneck pace without sacrificing quality in the process? Chances are
they can't, so unless Apple slows down, be wary of future software updates until you hear that
it hasn't caused any major problems.

Software will always have problems, but there's no point in releasing it too soon that it
frustrates everyone in the process. As Apple relies on iOS to run the iPhone, iPad, and Apple
Watch along with Car Play, both developers and consumers need to adopt Apple's latest
products with more caution.

Hopefully Apple will go back to making more reliable software without forcing everyone to
wait for immediate updates a few weeks later. Until that time arrives, stick with what works
and let other people be the guinea pigs to test the latest software updates until you're sure it
won't foul up your own devices.

Understanding Sabermetrics
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One reason why school bores the living daylights out of most people is because schools fail to
show how information can be relevant to each person's life. When you're taught abstract
principles that seem to have no purpose, you'll be far less likely to care and learn anything at
all.

So if you're a baseball fan, you might want to learn statistics by applying them to baseball by
reading Understanding Sabermetrics. The whole idea behind sabermetrics is to analyze
players based on their on base percentage, batting average, and other measurable statistics
about their performance. Now instead of arguing whether Barry Bonds was a better player
than Ricky Henderson, you can use statistics to compare players and determine who helped
their teams more often.

The book Moneyball was based on the Oakland Athletic's use of sabermetrics to find the best
players at the lowest possible cost. The common theory is that the more money you spend, the
better players you can afford and the better your team will be. Yet year after year, big budget
teams like the New York Yankees and the Boston Red Sox don't always do well despite
stocking their roster with stars. However, if you follow the Oakland A's, they tend to have one
of the smallest payrolls and a high percentage of winning seasons where they make the
playoffs.

In the movie Moneyball, you can see how getting the best hitters isn't as important as getting
the players who get on base most often through walks. If you can consistently get on base
(even without getting a hit), you have a chance of scoring a run. If you only focus on batting
averages, you overlook the players who tend to get walked often.

The whole point of sabermetrics is to find the players with the highest percentage of generating
runs and committing the fewest errors regardless of their salary. Statistically the more runs you
can score and the fewer errors you make, the more games you'll eventually win. Statistics just
improves the chances you'll win more often. In baseball where teams play many games,
statistics tends to be more accurate than in football where teams only play sixteen games.

Once you understand how statistics can improve a baseball team's chance of choosing the best
players, you can see how useful statistics can be in the real world. Now that you know how
statistics can help baseball teams like the Oakland A's, you can either use statistics to create
consistently good teams or you can use the common method of throwing money at players and
not always getting consistently good teams in return. As you can see, even when faced with
the practical results that the Oakland A's generate year after year, most teams still prefer the
expensive, unreliable method of buying costly players instead because they believe it works
even though it doesn't.

*                    *                    *

When most people get a form stored as a PDF file, they print it out, fill out the blanks, and
scan the image back into a PDF file again. To avoid wasting paper and time, the Preview

January 16, 2015 Understanding Sabermetrics

38

http://www.amazon.com/gp/product/0786433884/ref=as_li_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0786433884&linkCode=as2&tag=the15minmovme-20&linkId=BXSC7YRQYYOL4WIV
http://www.amazon.com/gp/product/0393324818/ref=as_li_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=0393324818&linkCode=as2&tag=the15minmovme-20&linkId=GC57AEZ3XSGIILK2
http://itunes.apple.com/us/movie/moneyball/id480245702?uo=4&at=10l4C5


program that comes with every Macintosh lets you markup PDF files directly without printing
anything.

Just open the PDF file in Preview and open the Markup toolbar by choosing View > Show
Markup Toolbar. Now you'll have access to various tools for drawing lines, shapes, and text
on a PDF file. Once you markup a PDF file, save it under a different name or the same name,
and send the marked up PDF file back to someone without printing anything at all.
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Figure 8. The Markup toolbar lets you add text, lines, and shapes to a PDF file.

In the early days, before Wally became an Internationally renowned comedian, computer
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book writer, and generally cool guy, Wally Wang used to hang around The Byte Buyer
dangling participles with Jack Dunning and go to the gym to pump iron with Dan Gookin.

Wally is responsible for the following books:

Microsoft Office 2013 For Dummies

Beginning Programming for Dummies

Beginning Programming All-in-One Reference for Dummies

Breaking Into Acting for Dummies with Larry Garrison

Strategic Entrepreneurism with Jon and Gerald Fisher

How to Live with a Cat (When You Really Don't Want To)

The Secrets of the Wall Street Stock Traders

Mac Programming For Absolute Beginners

Republican Fairy Tales (Children's Stories the 1% Tell About the Rest of Us)

The Zen of Effortless Selling with Moe Abdou

The 15-Minute Movie Method

Math for the Zombie Apocalypse

How to Write a Great Script with Final Draft 9

Making a Scene: The Science of Scene Structure

In his spare time, Wally likes blogging about movies and writing screenplays at his site "The
15 Minute Movie Method," finding interesting news stories about cats at his site "Cat Daily
News," giving advice to authors who want to self-publish e-books at his site "The Electronic
Author," and providing the type of advice he wishes someone would have told him when he
was much younger at his personal Web site. Wally can be reached at
wally@computoredge.com or you can follow him on Twitter @wallacewang_com.
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Worldwide News &
Product Reviews
“The latest in tech news and hot product
reviews.” by Charles Carr, News and Reviews
Editor

Another CES Has Come and Gone, What Did We Learn?; Run Windows Apps on Macs and Linux PCs
Without Windows (the Triquel).

Another CES Has Come and Gone, What Did We
Learn?
By now, hopefully all of us who first sprinted, then trudged, then slogged through this year's
2015 International Consumer Electronics Show (CES) have recovered.

According to Distributed Computing
Industry Association's (DCIA) CEO Marty
Lafferty, the 2015 International CES
attracted 170,000 total attendees (versus
160,000 in 2014), occupied 2.2 million
square feet (up from 2.05 million in 2014),
hosted 3,600 companies including 375
start-ups, and welcomed 40,000
international delegates from 150 countries
outside the US.

So, what made headlines at the show? What did we learn? What's in store for the year ahead?
In addition to my own comments in weeks to come, the DCIA's weekly newsletter has neatly
compiled excerpts from and links to several sources:

At the International CES: The IoT Hits Home
Excerpted from NY Times Report by Molly Wood

By just about any measure, the International Consumer Electronics Show is big. The event,
held in Las Vegas, NV, attracts more than 150,000 visitors. It occupies over two million
square feet, the equivalent of about 35 football fields, of exhibition space. More than 3,500
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companies come to show their wares.

But something has been lacking in recent years: big excitement. Companies have promoted
largely unwelcome new versions of existing products, like 3-D television, or new devices
with little consumer appeal, like clunky virtual-reality headsets.

This year, though, the International CES has been energized by a wave of new exhibitors
chasing a top trend in consumer electronics: the Internet of Things (IoT). The term refers to
the concept of a world full of connected devices controlled through a consumer-friendly hub,
like a smartphone app.

The new devices at the event, which opened to the news media on Monday and to the public
on Tuesday, include a Wi-Fi-connected ceiling fan controlled by a Nest Learning
Thermostat, and automated door locks, light switches and LED bulbs. Under Armour, the
sports apparel company that has experimented with smart sports clothing, is exhibiting at
CES, as well as the Girl Scouts of America, which is introducing a new digital app.

"This is the digital lifestyle not just coming into concept but into practical execution," said
John Curran, Managing Director of Communications, Media and Technology at the
consulting firm Accenture. "The Internet of Things is touching almost every aspect of your
life. Read more...

IoT Showcases the Connected Life at CES
Excerpted from LA Times Report by Andrea Chang

Everywhere you look at the Consumer Electronics Show (CES), it seems there's nothing that
can't be connected to the Internet: tennis rackets, coffee makers, watches, jewelry, baby
clothing, pet accessories, oven ranges, and infinitely more appliances and household goods
are all getting high-tech upgrades.It's called the "Internet of Things (IoT)."

To Shawn DuBravac, Chief Economist of the Consumer Electronics Association (CEA),
which organizes the International CES, the important consideration is not whether a
product can be digitized, but whether it should be. The question, he said, is ultimately "Does
it make sense?"

Historically, crowds have flocked to the annual show to find out "what's technologically
possible, what's technologically feasible," DuBravac said. "But we're now shifting, and no
longer is the focus on what technologically can be done, it's what is technologically
meaningful."

With so many competing Internet-connected products vying for attention at the massive event
— more than 150,000 people are expected to attend Tuesday through Friday — many will
ultimately fail. CES has become a place to "try to differentiate the winners from the losers,"
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DuBravac said. "As we digitize and connect and sensorize an increasing swath of our
experience, CES becomes that pruning ground."

It's hard to know where to start trimming. There are 900 IoT exhibitors at CES, the largest-
ever showcase of such offerings. Read more...

Samsung Preaches Harmony in Internet of Things
Push
Excerpted from Wall St. Journal Report by Jonathan Cheng

Openness, togetherness, and collaboration.

If Samsung Electronics has ambitions of dominating what it calls the next frontier in
technology innovation, it wants to do so only with the loftiest and gentlest of words. The
"Internet of things" or "IoT" as it's called in Silicon Valley parlance purports to link the
world's various appliances and devices, from refrigerators and televisions to smartphones
and light bulbs. And BK Yoon, one of Samsung's three co-chief executives, wants you to
know that it's a very big deal. "Huge," he said, during a keynote speech at the Consumer
Electronics Show in Las Vegas, NV. "A game changer." "The most important topic for our
industry right now," something that "will revolutionize our lives" and "unlock infinite
possibilities."

Diving into the IoT also makes good business sense for Samsung, whose dominance in the
global smartphone industry is under heavy assault. Samsung, which is expected to offer
preliminary fourth-quarter operating profit figures this week, has suffered a string of
disappointing earnings reports over the past year as competitors in China, India, and
elsewhere eat into its market share.

As a result, Samsung is trying to seize leadership in the development of the IoT, which gives
it a potential new channel for generating profits. Read more...

2015 CES: Big-Name Companies Betting on IoT
Excerpted from InvestorPlace Report by Robert Martin

Less than a week into 2015, it's pretty safe to crow the "Internet of Things (IoT)" as the
buzzword of the year — at least it sure seems that way based on the Consumer Electronics
Show (CES) taking place in Las Vegas, NV this week. At the 2015 CES, everyone from hot
tech companies to appliance makers to apparel makers were unveiling new, sexy connected
devices.
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For those who need a refresher, the IoT refers to the idea that more and more devices —
from your smartphone to your television to your car — will be connected to the web in
coming years. In fact, experts predict there could be as many as 212 billion by the year
2020.

Of course, tech companies getting in on this trend is hardly news. Just last month, Intel
announced a new suite of products called the IoT Platform. But beyond that, let's take a look
at a few big-name companies that followed in Intel's footsteps at 2015 CES.

BlackBerry: Struggling phone-maker BlackBerry is the first name that's hoping the IoT can
give its business a much-needed boost. The company is hoping that its "reputation for
security and reliability" will be enough reason for companies in the automotive and asset-
tracking industries to install BlackBerry technology on their devices, according to
CBCNews. BlackBerry also plans to expand its IoT push to smart energy and healthcare.

Samsung: Next up, we have another phone-maker, although Samsung makes much much
more than just phones. Read more...

Internet of Things Dominates CES in Las Vegas
Excerpted from Santa Cruz Sentinel Report by Troy Wolverton

As the official pre-show showcase strongly indicated, the International Consumer
Electronics Show (CES), which ran all week in Las Vegas, really was dominated by the
Internet of Things (IoT).

At the CES Unveiled press preview, companies exhibited a wide range of everyday gadgets
notable for their inclusion of sensors and ability to connect to other devices. On display
were everything from fitness bands and smartwatches to connected coffee pots and even bike
pedals.

Among the more notable or unusual products rolled out:

A "smart" air vent from a company called Ecovent that, in conjunction with temperature
sensing power plug, will open and close automatically to adjust the temperature in
particular rooms. The vent and the power plugs can communicate with smart thermostats
such as Nest's or with a smartphone app.

A Wi-Fi connected tea kettle from a company called Smarter that allows users to get their
tea water hot before they get out of bed via a smartphone app. They can also program the
kettle to turn on when they arrive home or pull up in the driveway.

"Smart" binding clips for snowboards from Japanese company Cerevo that records user's
weight balance on the board and the movement and vibration of the board. Users can
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download the data to a smartphone app, allowing them to analyze and visualize their runs.
Read more...

The 9 Best Ideas from 2015 CES
Excerpted from FastCoDesign Report by Mark Wilson

The Consumer Electronics Show (CES) brings tens of thousands of new products to our
shelves. Here are the nine you actually need to know about from the 2015 show.

You won't find a journalist alive who covers the annual CES and doesn't find it a miserable
experience. You're basically trapped in the bowels of Las Vegas casinos, staring at 200
identical TVs and trying to distinguish the difference.

But it's all almost worth it. Because every year, a few standout products pave the way for an
entire industry of innovation. These are nine artifacts, seemingly sent back from the future
to show us what's coming next.

3-D printing has a lot of limitations, the worst of which may be that most home 3-D printers
are printing solely in plastic. But Makerbot has introduced new filaments that, while still
plastic at heart, contain tiny particles of wood, stone, or metal, resulting in products that
can mimic the finish of limestone or bronze. You won't be able to print your next set of steel
cookware on a Makerbot, but for crafts and jewelry, it's an exciting development in domestic
3-D printing.

Another big limitation in 3-D printing is that, if you want to create an electronic device of
any sort, you usually have to print the body in pieces, which will jigsaw together and
sandwich themselves around the functional components. But at CES, a printer called Voxel8
demonstrated that it could print the plastic body and metal circuitry of a drone, all at once.
Read more...

FTC Warns IoT Businesses to Bake In Privacy and
Security
Excerpted from TechCrunch Report by Natasha Lomas

The US Federal Trade Commission (FTC) has raised concerns about the complexity and
privacy risks posed by the rise of an Internet of Things (IoT), with some 25 billion connected
objects predicted to be online in 2015, and so-called smart home devices predicted to
number around 25 million this year.

Concerns about privacy could encourage consumer mistrust of IoT devices, the FTC has
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warned, having a knock-on impact on consumer adoption. To avoid that scenario it has
detailed some of the measures it thinks IoT companies should take to mitigate privacy risks.

FTC Chairwoman Edith Ramirez was speaking at the Consumer Electronics Show in Las
Vegas, NV, after touring the show floor where exhibitors are showing off a swathe of
connected objects they hope consumers will be installing in their homes in future.

"The Internet of Things has the potential to provide enormous benefits for consumers, but it
also has significant privacy and security implications," warned Ramirez.

"Connected devices that provide increased convenience and improve health services are also
collecting, transmitting, storing, and often sharing vast amounts of consumer data, some of
it highly personal, thereby creating a number of privacy risks."

She went on to detail three particular privacy challenges that companies in the IoT space
will need to grapple with. Read more...

CES: Wheeler Hints at Utility-Style Rules for Internet
Excerpted from CED Magazine Report

US Federal Communications Commission (FCC) Chairman Tom Wheeler appears poised to
propose new rules that would classify Internet service providers (ISPs) as public utilities in
a move designed to ensure everyone has the same access to free content online.

Wheeler strongly indicated Wednesday that he favors the shift to tougher regulations,
describing it as "just and reasonable" during an appearance in Las Vegas, NV at the
International CES, a technology industry gadget show.
The remarks suggest that the head of the FCC is falling in line with President Barack
Obama, who announced in November that he favors governing ISPs like telephone
companies to preserve a "free and open" Internet.

Major ISPs fiercely oppose the change, arguing it will kill jobs and discourage them from
investing in network upgrades.

Any revision to Internet regulations still must gain the support of at least two other
commissioners besides Wheeler on the FCC's five-member voting panel.

Wheeler said he intends to release the full details of his proposal February 5th. The FCC is
scheduled to vote on the issue February 26th.

A federal appeals court threw the future direction of Internet regulation into limbo nearly a
year ago when it overturned previous rules designed to preserve "Net Neutrality." Read
more...
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BitTorrent to Release its First Feature Film
Excerpted from Fast Company Report by Evie Nagy

Before Sony decided to release "The Interview" on demand on Christmas Eve (after initially
canceling release plans altogether), BitTorrent made a case for distributing the
controversial Seth Rogen, James Franco comedy through its Bundle service. Now, the file
sharing network will in fact release its own first feature film as a pay-what-you-want
(PWYW) Bundle on February 13th: comedian David Cross's directorial debut, "HITS."

It will be the first wide release for the film, which debuted at Sundance last year. Written
and directed by Cross, HITS is a dark comedy about the pitfalls of Internet stardom (billed
as "a true story that hasn't happened yet").

A young woman (Meredith Hagner) who's obsessed with landing a role on The Voice instead
has to deal with the instant celebrity of her activist father (Matt Walsh, glorious as bumbling
communications director Mike McLintock on Veep) after his outburst at a town hall meeting
goes viral. The film also features comedian Wyatt Cenac and Cross's Arrested Development
costar Michael Cera.

BitTorrent's Bundle product has been used by a number of recording artists to sell albums
and multimedia content, as well as by film studios to distribute extended trailers and
ancillary material, but this will be the company's first feature-length release. BitTorrent's
peer-to-peer (P2P) technology allows for sharing and downloading large media files, and
Bundle protects the content behind a gate that can be unlocked for a price set by the
publisher, or in this case whatever the viewer wants to pay. Read more...

What IoT Investors Need to Watch in 2015
Excerpted from The Motley Fool Report by Chris Neiger

There is plenty of media coverage of the Internet of Things, or IoT. I've contributed my fair
share. But while many of those stories focus on connected thermostats, fitness bands, and
smart watches, there are much larger trends influencing IoT.

Admittedly, these trends aren't anything new. Big Data, security, and even predictive
maintenance have all been around for a while. But in 2015, we can expect each of them to
become a much bigger part of IoT than ever before.
Big Data will get even bigger. Cisco Systems expects 25 billion "things" to become
connected to the Internet this year, and managing all the data those things create will
become increasingly important.

David Cearley, a Vice President at Gartner, said recently in the research company's report
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on strategic technology trends for 2015 that, "Organizations need to manage how best to
filter the huge amounts of data coming from the IoT, social media, and wearable devices,
and then deliver exactly the right information to the right person, at the right time. Analytics
will become deeply, but invisibly embedded everywhere."

In short: Companies can't just make IoT devices, they must also manage the data they
collect.

We've already seen evidence of this. Last year, big IoT players Intel, General Electric, and
Sierra Wireless all introduced or expanded their own IoT platforms for managing embedded
connections. Read more...

In 2015 Big Data Will Drive the Internet of Things
Excerpted from InfoWorld Report by Yves de Montcheuil

With the Consumer Electronics Show (CES) in Las Vegas, NV capturing a lion's share of
this week's coverage in both IT and consumer media, it seems obvious that 2015 will be The
Year of the Connected Object. Smart home appliances, wearables, digital health devices,
robots, 3D printers, entertainment systems, car electronics, and other sensors and trackers
of all sorts are setting the pace of the Internet of Things (IoT) this year. Will Time Magazine
go so far as to feature on their cover this year a Fitbit fitness tracker, a Roomba cleaning
robot, or a Google self-driving car?

These connected objects, which are all the craze, belong to two categories: sensors, and
actors (some belong to both). Sensor objects measure data, while actor objects perform an
action. Examples of sensor objects include thermostats, activity trackers, heartbeat
monitors, and wear-and-tear sensors; examples of actor objects include thermostats (again),
smart switches, and pacemakers. Some objects are both sensor and actor: the smart
thermostat is a good example, but so are many implantable medical devices or industrial
appliances.

Connected objects, by their very nature, are not autonomous. They communicate at regular
intervals with a service provider which centralizes the data their have collected, enriches it
with data from other connected objects and/or external data sources, produces
reports/analytics, and if applicable provides instructions to the objects.
For example, a smart thermostat periodically measures room temperature, and reports this
measure to its backend service (typically, cloud-based). The backend service combines the
reported temperature, weather service data, and information about the routine of family
members. Read more...

Run Windows Apps on Macs and Linux PCs Without
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Windows (the Triquel)
Product name: CrossOver
Manufacturer: CodeWeavers, Inc.
Web site: www.codeweavers.com
Price: $39.95 including 1 month of email support & upgrades; $59.95 including 12 months
of email support & upgrades; $29.99 for support extension

CrossOver for Macintosh was at version 10 the last time we reviewed it. This
productivity/utility app's current version number is 14.0.3, and this latest and greatest has
several compelling enhancements to report. But before discussing CrossOver's noteworthy
new enhancements, a brief explanation of its function is in order.

CrossOver is a program for Macs and Linux PCs that runs many popular Windows
programs without Windows (Figure 1). Yes, that's correct—CrossOver runs many (but not
all) Windows applications, utilities, and games on Intel Macs and Linux machines without
paying for, installing, and/or booting Windows. With CrossOver, you need not purchase or
possess a product key for Windows. This means you can forget about creating and
maintaining a separate Windows partition on your Macs or Linux PC's hard drive; forget
about creating and maintaining a Windows virtual machine; forget about spending time
fussing with Windows Registry; and you also can forget about installing and running anti-
malware apps intended to protect Windows. In other words, CrossOver simplifies the use of
many (but not all) Windows programs on a Mac or Linux PC, thereby enhancing your
productivity.

How does CrossOver accomplish its magic of running Windows programs without having
any version of Windows installed on the Mac or Linux PC? CrossOver is a commercial
implementation (which comes with technical support) of a Unix open-source program called
Wine. This recursive acronym stands for "Wine Is Not an Emulator."

Whoa. Wine is not an emulator? That's correct, Wine does not emulate Windows. Instead,
Wine is a Windows "compatibility layer" for Unix variants (i.e., Linux, OS X) that includes
alternate implementations of Dynamic Link Libraries (DLLs) used by Windows programs.
This explains why, as mentioned above, CrossOver runs many but not all Windows programs
—it runs ones that use DLLs included in Wine, but does not properly (if at all) run Windows
programs that call DLLs missing from Wine (e.g., proprietary ones).
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Figure 1. CrossOver runs supported Windows programs (like Adobe Reader as shown on the left side of this screen
capture) without having any version of Windows installed on your Macintosh or Linux PC (right side).

If Wine is available for free and does the same thing as CrossOver, why buy CrossOver?
That's a good question, except that CrossOver does more than Wine (and includes technical
support). CrossOver, unlike Wine, has a single-click, graphical installer interface for
Windows programs (Figure 2); uses a portable virtual environment called a "bottle" that
simplifies archiving, backing up, and/or restoring your installations of Windows programs;
and seamlessly integrates with your Mac's or Linux's desktop (Figure 3).

Which Windows programs does CrossOver run on Linux PCs and/or Macs? The list of
officially supported programs includes many popular ones such as Call of Duty, Civilization
IV, Firefox, Internet Explorer 7, Microsoft Office (2003, 2007, and 2010), Quicken (2011-
2015 inclusive), and World of Warcraft III. A more complete listing (which includes a rating
—bronze, silver, or gold—of each program's level of support) is available on CodeWeavers'
Web site.
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Figure 2. A difference between CrossOver (commercial software) and Wine (open-source) is the former's user-friendly
graphical interface for installing Windows programs.
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Figure 3. Windows programs running under CrossOver integrate with the host computer's operating system; an example
is CrossOver for Macintosh's Dock icon's contextual menu which lists all of the Windows programs installed to run

under CrossOver.

CrossOver 14, like its predecessors, is a piece of cake to install and get up and running.
After downloading the free, 14-days, fully featured demo, installation consists of moving the
application file to your computer's Applications folder . You're now ready to install
Windows programs you want to use. CrossOver can install Windows programs distributed
on installer CDs or DVDs (if your computer has an optical drive) or ones in installer files
(e.g., ISO). An illustrated explanation of CrossOver's user-friendly installation process is
included in the freely available user guide.
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A real-world example of how CrossOver can improve a Macintosh or Linux user's
productivity is shown in Figure 4. Instead of buying, installing, maintaining, and protecting
Windows just to use Word for Windows for collaboration with co-workers, you instead could
buy CrossOver—which costs less and consumes way less time to maintain than Windows—to
use Word.

Figure 4. Pages for Macintosh (right) opens and saves .doc files, but running Word for Windows under CrossOver (left)
ensures 100% compatibility with coworkers who use PCs.

What if you want to use a Windows program that's missing from CodeWeavers' list of
supported ones? You still can install and test it for compatibility. I have two such programs,
and they run sufficiently well (albeit with some glitches) for me to be productive. In the
event that such a program does not run properly under CrossOver, however, you can become
an advocate for it to be supported in a future version of CrossOver.

So what's new and compelling in CrossOver 14? First and foremost is its user interface. The
new interface will look familiar to veteran OS X users because it closely resembles a Finder
window complete with a user customizable toolbar and the Finder's three standard views—
Icon (shown in Figure 5), list, and column.
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Figure 5. CrossOver 14's new user interface replaces older versions' Programs menu with a Finder-like window that
displays installed Windows programs in Icon (shown), List, or Column View.

Second, CrossOver 14's new user interface includes an overhaul of how bottles are
displayed. It, too, resembles a Finder window (Figure 6). As mentioned earlier, each bottle
is a virtual Windows environment and has its own C: drive, standard sub directories
(Windows, Program Files, etc.), CrossOver settings, and one or more Windows applications.
CrossOver supports multiple bottles, and each one can contain its own Windows virtual PC.

Lastly, CrossOver 14 includes support for additional Windows programs (e.g., Quicken
2015) and is based upon Wine 1.7.25 which includes bug fixes and improved Windows
compatibility.

Linux users' prices for CrossOver are the same as Mac users', and they vary according to
the length of included technical support and updates—$39.95 for one month, $49.95 for six
months, and $59.95 for one year. A year's extension of access to technical support and
updates costs $29.95.
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Figure 6. CrossOver 14's new user interface for displaying the user's bottles (virtual Windows environments) resembles a
Finder-like window with a sidebar, contextual menus, and a customizable toolbar.

Our previous review's conclusion is as appropriate for CrossOver 14 as it was for
CrossOver 10…the money and time that this program saves by eliminating the need to
purchase, install, and maintain Windows for the sake of running supported Windows apps
far outweighs CrossOver's modest price tag ($39.95 for one month's support and updates,
$59.95 for twelve months'). If CrossOver supports the Windows program(s) you need or want
to use, what are you waiting for?

 for supported apps
Review contributed by Barry Fass-Holmes

Multiple award-winning author Charles Carr has written more than two thousand
newspaper articles, magazine stories, and columns for many publications including the San
Diego Union Tribune, The Californian, The North County Times, Parent Magazine,
ComputerScene, and ComputorEdge Magazine where he has been an editor for more than
two decades. He is also a television producer/director with shows both currently airing and
in production on Cox Cable and elsewhere.
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In the 1990s, Charles wrote 3DHouse, a complete inside-and-out virtual reality tour of his
family's log home in Southern California. One of the first virtual reality programs ever
created, 3DHouse enjoyed tens of thousands of shareware downloads on all major portals.
He also sold the rights to Radio Shack and Egghead Software. 3DHouse has since been
featured in many books and articles about VR.

Carr has also been commissioned to write and/or directed many of his own stage plays.
Several years ago, Carr and others looking for ways to help organizations struggling in
difficult economic times, founded Art Animates Life (www.artanimateslife.org).

To date, Art Animates Life, a CA incorporated, federal non-profit, has raised tens-of-
thousands of dollars for San Diego area disaster relief, an arts non-profit and municipal gallery,
a community outreach center, and several struggling community theaters.

Several years ago Carr was commissioned to adapt and direct the beloved Dickens classic, A
Christmas Carol. The play, titled "Mr. Scrooge & Mr. Dickens," has sold out So Cal theaters
for the past several years. Six shows will take place Dec. 2013 to benefit the San Marcos
Historical Society.

Another original play, "All the Time in the World," has been performed many times and
garnered broad acclaim from audiences and critics alike. Carr is working on a brand new
adaptation of the classic Hitchcock thriller, "The Lady Vanished," to be performed spring
2014.

Carr has won many writing accolades, including San Diego Press Club awards for Best
Column Writing, Best Consumer Writing, and Best Arts and Entertainment. He has repeatedly
taken top honors in San Diego Songwriter's Guild competitions for his original musical
compositions.

Carr is also a noted producer, director, and videographer. Several of his documentaries can
currently be seen on So Cal's Cox Cable. Since its inception he has produced the Fallbrook
International Film Festival's red carpet event and panel discussions.

Charles receives dozens of requests each year to appear on Southern California television and
radio stations to talk about important tech events. He also speaks from time-to-time to high
schools and organizations about his eclectic life in the arts.

Learn more at www.charlescarr.com.
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Editor's Letters: Tips and
Thoughts from Readers
“Computer and Internet tips, plus comments on the

articles and columns.” by ComputorEdge Staff
"Copy with All Sub Directories," "Today's Column," "Dot Net"

Copy with All Sub Directories
[Regarding the January 2 Digital Dave column:]

I use Windows Robocopy. It has no limitations on filename length no matter which direction
you copy/backup/restore. It is best if used with a batch file. The documentation is extensive
(and somewhat difficult to get through!) but well worth the effort for backing up or mirroring
any folder. If your windows version doesn't include Robocopy it is readily available from
another operating system or from Microsoft and the net.

-Tim Hood, San Diego

I've been using a free utility for years caller Teracopy. It installs into the right mouse key menu
and provides a ton of copy/move options and I've never found it to get bogged down as
Windows does. It just works.

-John H, Encinitas, CA

Today's Column
[Regarding the January 2 Digital Dave column:]

Simply a fantastic column today. Who said "you don't get better as you get older?"

-Gary Weinstein, California

Dot Net
[Regarding the December 26 Wally Wang's Apple Farm column:]
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"Then Microsoft decided to kill Visual Basic 6 and create Visual Basic.NET, which is more
complicated and harder to learn. "

This is a matter of opinion, sort of like saying that Windows is more complicated and harder to
learn than a Mac. For those of us who made the transition, it was a learning experience and
showed that most things are just as simple in VB.Net (just a bit different to apply.) And many,
many things are actually simpler once you learn the tools (just like learning the modern tools of
any profession such as plumber or electrician.) For the casual programmer, I'd say that both
are equally easy, but different. Read my articles from 2009 and you'll see that you can create a
VB.Net app in a matter of minutes without much experience.

"Visual Basic.NET is nearly as difficult to learn and use as C#, but not as powerful. As a
result, many Visual Basic programmers simply switched to C#."

By design, VB.Net is just as powerful as C# because they use the exact same routines
(although they often produce slightly different results because people program differently in the
two languages). In my opinion, many developers switched to C#.Net because the transition is
relatively easy and C# pays better in the market and has more professional support.

-Rob the Computortutor, San Diego

VB.NET is basically identical to C# so theoretically it's just as powerful as C#.
Realistically, even Microsoft seems to favor C# and third-parties tend to focus on providing
C# libraries while ignoring VB.NET. Of course you can mix VB.NET with C# libraries, but
if you want to program in a single language, it's probably best to use C# instead of VB.NET
since there are far more C# libraries and source code to use in comparison to VB.NET.

Since VB.NET is a clone of C#, there's little reason to use VB.NET. VB6 was drastically
simpler than C/C++. VB.NET code may be more readable than C# (at the expense of being
wordier) but the salary differences between VB.NET and C# programmers makes it more
lucrative to use C#. Given a choice between VB.NET and C#, there's no compelling reason
to use VB.NET.

-Wally Wang, ComputorEdge 

ComputorEdge always wants to hear from you, our readers. If you have specific comments
about one of our articles, please click the "Tell us what you think about this article!" link at
the top or bottom of the specific article/column at ComputorEdge.com. Your comments will
be attached to the column and may appear at a later time in the "Editor's Letters" section.If
you want to submit a short "ComputorQuick Review", or yell at us, please e-mail us at
ceeditor@computoredge.com. If you would like to review our recent e-books, please visit
ComputorEdge E-Books.
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